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If at first you don't succeed, destroy all evidence that you tried  

 

 

Microsoft: Longhorn Beta 
Unlikely This Year 

By Mike Ricciuti, CNET News.com 

REDMOND, Wash.--Microsoft's efforts to bol-
ster security in Windows XP will likely delay the 
release of a widespread test version of its forth-
coming operating system until next year, Micro-
soft's top executives told CNET News.com.  

Work on Windows XP will likely cause Microsoft 
to delay the release of a test version of Long-
horn until next year, executives tell CNET 
News.com.  

Microsoft has made the security of Windows its 
top priority. New security features are planned 
for updates, or service packs, for Windows XP 

and Windows Server 2003 later this year. 

Microsoft had said it planned to ship the test 
version of Longhorn, a major update to the 
company's Windows operating system, this 
summer. The company has reassigned a large 
number of developers working on Longhorn to 
build updates to the existing versions of Win-
dows to bolster security, said Jim Allchin, vice 
president of Microsoft's platforms group. 

Asked whether the company would make its 
self-imposed deadline for delivering a Longhorn 
beta by summer, Allchin said, "I don't believe it 
will be this year." He also said that some minor 
features planned for Longhorn will be cut to ac-
celerate development, then rolled into a future 
Windows release. "If we don't really know how 
to do something by now, it's probably time that 
we think about not putting it into the product," 
Allchin said. 
 
Submitted by:  Y. Bulger 
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If at first you don't succeed, skydiving is not for you  

Wireless called Key to Global  

Development 

By Ed Frauenheim CNET News BERKELEY, Calif.-- 

The bridge across the global digital divide is likely to 
be a wireless one ......  

At a conference here on using technology to solve 
social and economic problems in developing na-
tions, a number of speakers emphasized the role of 
wireless communications.  

A. Richard Newton, dean of the College of Engi-
neering at the University of California, Berkeley, 
said the most important technological step to take in 
developing countries is to build out communications 
networks with wireless capabilities.  

He said it is conceivable to put solar-powered an-
tennae towers that support voice and data commu-
nications in villages for about $750 apiece. Newton 
also proposed a mobile phone with a much simpler 
interface, one he claimed was economically feasi-
ble. The phone would display images of people who 
called, so a user reviewing voice mail could press 
on the image of the person whose message he 
wanted to hear. "I can build that phone for less than 
$5 today," he said.  

Newton was among the many scholars, public offi-
cials and business leaders participating in the 
"Bridging the Divide" conference organized by UC 
Berkeley's Management of Technology Program 
along with the United Nations Industrial Develop-
ment Organization. The three-day event, held at the 

university's Haas School of Business, examined 
topics including health care technology, building 
environmentally sustainable industry, and technol-
ogy essentials for economic development.  

Maggie Wilderotter, Microsoft's senior vice president 
in charge of the public sector worldwide, began a 
keynote speech Friday by painting a picture of a 
starkly divided world. She said 2.5 billion of the 
world's 6 billion people live on less than $1 a day. 
She also highlighted the importance of education. 
"What good is a laptop with broadband access if 
you can't read or write?" she asked.  

Still, technology can play a vital role in helping peo-
ple's well-being, she argued. Microsoft has a num-
ber of projects around the world designed to in-
crease technology access, with wireless as one fo-
cus. In Africa, Wilderotter said, Microsoft is helping 
nomadic people stay connected via satellite. "The 
school computer lab actually moves with them," she 
said.  

With many high-tech jobs moving from the United 
States to lower-wage countries such as India and 
China, some observers call for more attention to 
workers and technology at home. But concerns 
about "offshoring" should not mean ignoring the 
plight of the world's poor, suggested John Gage, 
chief researcher at Sun Microsystems. It's a ques-
tion of "who is 'us'--we are all 'us,'" Gage said. "It's 
just part of being a citizen of the world." 

Submitted by: Y. Bulger 



3 
 

 
  NANAIMO COMPUTER CLUB NEWSLETTER 
           
 

To steal ideas from one person is plagiarism; to steal from many is research  

U.S. tops international spammers' list 
 By Matthew Broersma  
 

The United States is by far the leading originator of 
spam received around the world, according to a 
study published on Thursday by U.K. antivirus com-
pany Sophos. The broad international spread of 
junk e-mail senders, with European and Asian coun-
tries also high on the list, underscores the difficulty 
of combating spam with national laws, Sophos said. 
An added difficulty is that many spam senders may 
not even be aware they are sending the messages, 
their PCs having been hijacked by the real culprits 
from across international borders.  The United 
States accounted for more than half of all spam 
sent, at 56.74 percent, Sophos said, with Canada a 
distant second place at 6.8 percent. The top-ranked 
European country was the Netherlands at 2.13 per-
cent, while the U.K. scored ninth with 1.31 percent. 
The top-ranked European spammers--the Nether-

lands, Germany, France, the U.K. and Spain--
together accounted for 7.82 percent of all spam re-
ceived. "Spam is a global problem, and countries 
worldwide are starting to take the issue more seri-
ously," said Sophos senior technology consultant 
Graham Cluley in a statement. "However, legislation 
in the U.K. won't protect users from spam coming 
from North America or China."  Sophos arrived at 
the figures by analyzing hundreds of thousands of 
e-mails received over two days last week in various 
locations around the globe.  The analysis only 
scratches the surface of understanding the spam 
problem, Cluley said, noting that about a third of all 
spam is sent from computers that have been com-
promised by junk e-mailers, often without the knowl-
edge of the computer owner.  Sophos said that 
many of the U.S. computers originating spam ap-
pear to be controlled by hackers in Russia and else-
where. 
 

Submitted by: Greg Wilson 

Google to Offer Gigabyte of Free e-Mail 
By Paul Festa, CNET News.com 

The company, based in Mountain View, Calif., on 
Thursday launched a test with about 1,000 invited 
guests set to try out a new email service called 
"Gmail."  

Google, which made its name in search but has 
added numerous services, such as a news aggrega-
tion page and a newsgroup interface, says that 
Gmail is search-based e-mail. 

Like Yahoo Mail and MSN Hotmail, Gmail will let 
users search through their e-mail. Unlike those com-
petitors, though, Google will offer enough storage so 
that the average e-mail account holder will never 
have to delete messages. 

Hotmail currently offers 2MB of free e-mail storage. 
Yahoo offers 4MB. Gmail will dwarf those offerings 
with a 1GB storage limit. 

Google plans to make money from the service by 
inserting advertisements into messages based in 
part on their content, effectively extending its Ad-

Words program for presenting contextual ads in 
Web pages to e-mail.  

"The idea is that your mail can stay in there forever," 
said Wayne Rosing, vice president of engineering at 
Google. "You can always index it, always search it, 
and always find  things from the past." 

When asked whether Gmail represented further evi-
dence that Google is muscling in on the turf of Ya-
hoo, MSN and other Web portals, Rosing demurred. 

"The way we'd like to say it," he said, "is that part of 
our mission is to organize and present all the 
world's information, and e-mail's part of that infor-
mation that currently is not well organized. That is 
the rubric under which we offer this." 

But one analyst said that Google's e-mail service 
should be able to siphon some consumers away 
from the company's rivals, given the level of storage 
and the proposed functionality.  

Submitted by: Y. Bulger 
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TIPS & TRICKS 
How to Get Rid of Old Unused User Profiles  
You may have created local user profiles for differ-
ent users to log onto your computer. Profiles save 
information about each user's preferences, desktop, 
etc. and can grow quite large. To delete them to free 
up disk space: 
 
Right click My Computer.  
Select Properties.  
Click the Advanced tab.  
Under User Profiles in the middle of the box, click 
the Settings button.  
In the list of profiles stored on this computer, high-
light the one you want to get rid of, and click the 
Delete button.  
Click OK twice to exit the dialog boxes. 
 
How to Add More Options to the "Send to" Menu  
The "send to" function in the right context menu is 
handy; it lets you right click a file and send it to the 
floppy drive, the desktop, the My Documents folder, 
a mail recipient, etc. But there might be other places 
you'd like to be able to quickly send files (for exam-
ple, to a folder you've created or a network drive). 
You can add more locations to the Send to menu: 

  
Right click Start and click Explore to open Windows 
Explorer.  
Navigate to the drive on which XP is installed 
(where the WINDOWS folder is located) and expand 
the Documents and Settings folder.  
Expand the folder for your XP account name.  
Expand the Send to folder (this is a hidden folder, 
so you might need to modify your Explorer options 
settings to show hidden files and folders first).  
In Explorer, right click the folder or drive you want to 
add and drag it into the Send to folder. Select Cre-
ate shortcut here.  
To show hidden files and folders, in Explorer click 
Tools | Folder Options, click the View tab, and 
check the box that says Show Hidden Files and 
Folders.  
 
Live Manuals.   
Can't find that manual for something you got for 
Christmas?  Try:  http://www.livemanuals.com along 
with product  simulations and interactive assistance. 
 
Submitted by: Greg Wilson 

Always remember you're unique, just like everyone else  

There was a pilot flying a small single engine charter plane, with a couple of very important executives 
on board.  He was coming into the Seattle airport, through thick fog, with less than 10 miles visibility 

when his instruments went out.  So, he began circling around looking for a landmark.  
After and hour or so, he starts running pretty low on fuel and the passengers are get-
ting very nervous.  Finally, a small opening in the fog appears and he sees a tall build-
ing with one guy working alone on the 5th floor.  The pilot banks the plane around, 
rolls down the window and shouts to the guy, “Hey where am I?”  To this, the solitary 
office worker replies, “You're in a plane”.  The pilot rolls up the window, executes a 
275 degree turn and proceeds to execute a perfect blind landing on the runway of the 

airport 5 miles away.  Just as the plane stops, so does the engine, as the fuel runs out.  The passengers 
are amazed and one asks how he did it.  “Simple,” replies the pilot, “I asked the guy in that building a 
simple question.  The answer he gave me was  100 percent correct but absolutely useless, therefore, 
that must be Microsoft’s support office and from there the airport is just five miles due East.”     
 

Taken from: The Patience News Issue #28 
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News—Previous Meeting 

GALAXIES, STARS & OTHER FLYING 
OBJECTS 

What a lot to absorb in one evening!  Gary 
Korpan was in good form as he led us through 
a fascinating, but brief review of our solar sys-
tem and beyond. The scope of his subject was 
amazing and, in the short time available, he 
covered a lot of ground. 
 
His initial comments related to the Club’s CD 
Utility disk, which was spoken of with great 
appreciation – our thanks to Wes Jackson  
There were many utility programs mentioned, 
and he referred to the article in the December 
2003 issue of the PAPER MODEM which 
gave more detail.  He was careful to mention 
that most of the  of the programs were free, and 
the members were busily writing down the web 
addresses he gave out.  He stressed the neces-
sity of virus protection programs and the value 
of constant monitoring of your PC.  It is well to 
remember that the writers of these malicious 
programs are always ahead of the authors of 
the protections.  
 
The images of the stars and galaxies were truly 
amazing.  The distances could hardly be imag-
ined and when you consider light travels at 

about 186,000 miles/second the science that 
produced these pictures is mind-boggling.  One 
slide which stood out in my mind was the one 
depicting the orbits of the various satellites 
around the earth.  There were so many and the 
task of keeping their orbits exclusive is a major 
one.  Apparently there have been collisions 
which produce space debris – and there is no 
vacuum cleaner to pick up the pieces either!! . 
The colours in the galaxies were outstanding 
and it was hard to imagine how they could be 
so far from earth and look so clear.  One slide, 
taken by the Hubbard Space Telescope re-
cently showed the farthest star clusters found 
so far – the distance was truly ‘out of this 
world’. 
 
We were told that the City of Nanaimo website 
is under a major revision and will be available 
for viewing in about three weeks. It is an ex-
cellent site now, and we’re sure it will be much 
improved when we see it in the near future. 
 
An excellent evening, full of information and 
knowledge – again, thanks Gary. 
 
Submitted by Alan Forrest 

Borrow money from a pessimist, they don't expect it back  
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March 16 Meeting. A Windows XP  
Q & A Forum 

 
This was an auspicious occasion. Not only did we 
get to talk and demo the operating system, but we 
were the first community group to use the ADSL 
resource at Beban Park. It was great to be able to 
go on line at high speed - typically 265 Kb/s - and 
retrieve data at will. 
  
My personal thanks to Gord Bulger and Steve 
Wawrykow for helping me handle the XP questions. 
Quite a few were sent in and many were not an-
swered at the time.  Here are some of the 
“leftovers”: 
Q. Why do I receive images that just appear as 
empty boxes with a little red X in them. 
 
A. (Many possibilities). 1. In Internet Explorer go to 
Tools > Internet Options> Advanced > Multimedia - 
make sure Show Pictures is checked. 
2. By default Windows XP opens all picture files with 
Windows Picture & Fax Viewer. Click on My Pic-
tures > View - then try Filmstrip or Thumbnails to 
view your files. 
3. Perhaps you are trying to view Java applets. Go 
to your Control Panel. One of the icons should be 
the Java coffee cup (Java Plug-in). If you don’t have 
one, go to http://www.java.com/en/index.jsp Go to 
the box on the right for the free download - I prefer 
the Manual download, you may prefer Automatic. 
This installs the Java Runtime Environment, Stan-
dard Edition 1.4.2_04. 
 
Q. What is Direct X.  
 
A. DirectX 9.0b is a Windows XP technology re-
quired for use with many games, security and other 

high-end multimedia applications. It is a system 
component which cannot be uninstalled. 
 
Q. If Windows XP is stable, are there any traps to 
be avoided. 
 
A. Assuming Windows XP was properly installed 
initially, the need is for an organized plan to main-
tain it. The recommended sequence is as follows: 
  
Use Windows Update to keep you automatically 
informed of updates, but don't go for automatic 
downloading & installing. Do install all Critical Up-
dates and new Drivers promptly. Don't install any 
of the regular updates that you don't need. 
[Currently there are 6 regular updates I have de-
clined to install because they apply to features of 
Windows XP that I never use]. 
Go through View Installation History from the old-
est date to the current date. Verify that any entries 
shown as Failed or In Progress have subsequently 
been followed by a Successful entry with the same 
description and KB number. If there any entries not 
corrected by a Successful entry, go to the MS Up-
date web site and download the KB article and in-
stall it yourself. 
Go to www.belarc.com and download and install the 
free Belarc Advisor program and run it to get your 
Computer Profile. Make sure that under the list of 
Installed Microsoft Hotfixes there are none with a 
red X indicating a HotFix that fails verification. I 
have found that the Microsoft Installation History 
can show a HotFix installed successfully which 
failed verification by Belarc Advisor ! If this happens 
to you, reinstall the failed file, or if you are really 
interested go to the next step to get all the details. 
Go to http://www.microsoft.com/
downloads/      Search for and display Article 

(Continued on page 7) 

Fred’s XPosé  

 
A diplomat is someone who can tell you to go to hell in such a way that you 
will look forward to the trip  
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282784. Follow the instructions on How to Obtain 
Qfecheck.exe for Windows XP Home and Windows 
XP Professional. Download and install 
qfecheck.exe in your C:\Windows\System32\ 
folder. Opt to have the log with your computer name 
appear on the desktop, or other location of your 
choice. 
Then go to Start -- Run and type 
C:\Windows\System32\qfecheck /l /v             in the 
Open box - (note the space before /l and before /v). 
Then click on OK. The result should be a Windows 
XP HotFix Validation report which will appear briefly 
on screen, then disappear. Now go the location you 
selected and you should find a (computer name).log 
file waiting for you to read when you click on it. This 
report should provide a list of all the Hotfixes Identi-
fied, and against each it should show Current on 
system. If there is a problem with a hotfix it will 
show: 
 
        This hotfix should be reinstalled. The following 
files are incorrect for this hotfix. 
 
[ On one of my machines, against just one hotfix it 
listed 36 files as incorrect !] 
After downloading and reinstalling the invalid hotfix 
run qfecheck again to ensure that all entries are 
Current on system. 
"If you are an advanced user" you can install the 
Windows Recovery Console as a startup option. 
See Microsoft KB Article 307654 for details. It helps 
gain access to your Windows installation to replace 
damaged files and enable/disable services. You 
MUST be the Administrator to use this console. 
Start the Recovery Console from your hard disk or 
from the Windows Setup CD. It requires about 7MB 
of disk space. To install it on your hard disk, put the 
Setup Cd in the CD drive. When the installation 
menu comes select Exit. Then go to Start -- Run 
and enter D:\i386\winnt32.exe /cmdcons and click 
on OK. 
The Weekly list - Defrag all hard drive volumes. Use 
the Win XP program. I consider it adequate. Don’t 
worry about doing it too often. Analyze first and the 

program will tell you if Defragment is necessary. 
Then do the Checkdisk, again using the Win XP 
program. After that I recommend a good registry 
cleaner. I haven’t found a freebie I’m happy with. 
For the average home user I like Registry First Aid 
3.0  One reason I like it is that as soon as you call it 
up it gets you to Create a Restore Point - before 
you start the cleanup, and it backs up your final ac-
tion. The registry typically contains 10,000 entries 
so the first time you run it will be a long job - enjoy a 
long lunch. After that, sticking to a weekly routine 
will be relatively short. 
 
That’s it for the basic operating system, but of 
course we have the troubles that come down the 
line. Spam, Viruses, Hackers, Pop-ups, Data Min-
ers, Trackers - the list goes on. First you need a 
decent software firewall. The current offering built 
into WinXP SP1a is definitely not good enough. It 
does nothing at all for outgoing traffic. You don’t 
have to pay for a good program. I use ZoneAlarm 
[free version] on one machine and Sygate [free ver-
sion] on the other. I prefer Sygate. It is less intrusive 
and friendlier. Then you need a decent hardware 
firewall. There are many alternatives. I use one 
which is inherent in my U.S. Robotics Router. How 
so I check it. Again once a week, normally, I run a 
freebie test program which you can download from 
http://www.hackerwatch.org/probe  I run the Port 
Scan to make sure my system is secure. 
 
Now for the Daily Security routine. For anti-virus I 
like AVG 6.0 as a freebie.  Make sure you configure 
the Update Manager to Update if database is 
older than 1 day. The default is a week which is 
simply not good enough. For a small outlay, initially 
U.S. $19.95 and then $9.95 a year I really like 
eTrust EZ Antivirus from Computer Associ-
ates.  [Veteran club members will remember this as 
InoculateIT when it was free]. It can be configured to 
update automatically and it does it every day, and 
tells you too! C.A. is said to be the third largest soft-
ware company in the world, best known for its ac-

(Continued from page 6) 

(Continued on page 8) 

Duct tape is like the force, it has a light side and a dark side and it holds 
the universe together  
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Submit all items for sale to ybulger@shaw.ca 

counting systems from Simply Accounting on up to the really big packages. I use AVG on one machine 
and eTrust on the other. 
 
Now to Spam. Everybody - In Outlook Express 6.0 - go to View > Layout > Preview Pane and make 
sure there is NO checkmark in the Show preview pane box. If you fail to do this you will be reading the 
spam message every time you select it! 
I don’t use any resident spam programs on my two machines any more. I am extremely happy with the 
Telus Spam Control on my ADSL link. About 98% of the spam is deleted by Telus at the server. The cou-
ple of messages that do get through I deal with by selecting them in the Inbox then right clicking and 
choosing Forward As Attachment from the context menu. From my Address Book I then pick re-
port_spam and put that in the To: line and then move the cursor to the body of the message before click-
ing on Send. [It goes to report_spam @telus.net and I can put all the attachments in one message]. As 
soon as I see the report has been sent I press the Delete button to get rid of the still selected spam mes-
sages . My wife uses Spam Inspector (she is on Shaw Cable). It is not free, but it is a pretty good program 
compared to other “on machine” offerings. 
 

(Continued from page 7) 

 
VIDEO CARD  GeForce 4 MX440 64 MB AGP …….$50.00.    

Ask for Ben, 756-3195 
 

 
Rattan Suite 

 
 
 

 

 
 
 
 
Contact: Betty or Walter 

At 390-3400 
 

The End. 
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